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Chapter 2

Introduction

UltraDefrag is a powerful disk defragmenter for Windows. It can quickly boost performance of your computer and is
easy to use.

UltraDefrag has the following features:

• fast and efficient defragmentation algorithms

• safe environment preventing files corruption

• detailed file fragmentation reports

• defragmentation of individual files/folders

• defragmentation of locked system files

• defragmentation of NTFS metafiles (including MFT) and streams

• exclusion of files by path, size and number of fragments

• fully configurable disk optimization

• drive processing time limit

• defragmentation of disks having the specified fragmentation level

• automatic hibernation or shutdown after the job completion

• multilingual graphical interface (over 60 languages available)

• one click defragmentation via Windows Explorer’s context menu

• powerful command line interface

• scheduled defragmentation (using Windows Task Scheduler)

• small size of installers (about 2 MB)

• availability of portable packages requiring no installation

• full support of 64-bit editions of Windows

• granted permission to freely use and redistribute the program

UltraDefrag can defragment both FAT and NTFS disks with just a couple of restrictions:

• It cannot defragment FAT directories, because their first clusters are immovable.

• It cannot defragment master file tables (MFT), because their first 16 clusters are immovable.
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However, the program tries to optimize those files placing their fragments close to each other behind the first one.

UltraDefrag can be used on Windows XP/Vista/7/8/10 as well as Windows Server 2003/2008/2012/2016. Elder
versions of the program (prior to v7) can be used on Windows NT 4.0 and Windows 2000 as well, with some
limitations. Additionally UltraDefrag for Linux exists which is an independent port of the program based
on NTFS-3G capabilities.

Algorithms

First of all the program analyzes the disk gathering complete information about files and free space gaps.

Then, depending on the selected action, the program either defragments the disk or performs its optimization.

Defragmentation eliminates little fragments joining them together.

Full optimization moves all small files and fragments to the end of the disk to release some space in the beginning.
Then it moves them back, sorted by a user defined criteria, to speed up access to groups of small files. By default
files are sorted by path in ascending order. Additionally FAT directories and NTFS master file tables get fixed up as
mentioned above.

Quick optimization is the same but it skips already sorted out files.

All algorithms are available either from a traditional graphical interface, or from a command line (console) interface
suitable for batch scripting and scheduled tasks. Additionally a boot time interface exists which helps to defragment
files locked most of the time.

Files

UltraDefrag doesn’t count empty files because they have no fragments at all. The same applies to small files living
inside of MFT records. Usually they are smaller than 1 KB and require no clusters outside of the table, thus no
fragments. However, when you right click those files in Windows Explorer and select Defragment with UltraDefrag
they will be counted to avoid ambiguity.

Additional treatment have files excluded from defragmentation. Files marked as temporary by the operating system
are always excluded, others can be cut off by path, size and number of fragments using filters. The program never
treats those files as fragmented even if they actually are.

For higher performance usually it does make sense to exclude not only temporary content, but also large fragments.
For example, when you watch a movie Windows needs just a couple of milliseconds to advance from one large
fragment to another, while the overall watching time is usually about 2 hours. Thus, you will never suffer from large
file fragments when you watch a movie.

Taking into account all the above the disk fragmentation level is calculated as follows:

fragmentation level =
number of fragments needing elimination

total number of fragments

Web resources

Everything related to the program can be found at UltraDefrag website.
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Installation

The latest version of the program can be obtained at SourceForge. Both installers and portable packages
are available. The latter require no installation, thus can be used directly from USB sticks. They include all the
components except of the boot time defragmenter.

All the binaries are available for three processor architectures: x86, AMD64 and IA64. The first one is for 32-bit
editions of Windows. The next one is for 64-bit editions. The last one is for Intel Itanium driven computers running
Itanium editions of Windows.

For example, if you need UltraDefrag for Windows XP 32-bit edition download the x86 installer. If you need it for
Windows 7 64-bit edition, download the AMD64 installer regardless of the processor you have.

Note

You must be an administrator to install and run UltraDefrag.

The installation process is pretty straightforward, only one thing deserves to be mentioned. During startup the
program sends a bit of usage statistics to the Google Analytics service. It helps us to understand better your
needs. However, you may turn this feature off during the installation.

Silent mode

UltraDefrag can be installed silently (without graphical dialogs) using additional command line switches:

/S

Install the program silently.

/FULL=1

Install all the components.

/MICRO=1

Install the console and boot time interfaces only.

/GUI=(1|0)

Install or remove the graphical interface.

/CONSOLE=(1|0)

Install or remove the console interface.

https://sourceforge.net/projects/ultradefrag/files/
https://en.wikipedia.org/wiki/Portable_application
https://www.google.com/analytics/
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/BOOT=(1|0)

Install or remove the boot time interface.

/HELP=(1|0)

Install or remove this handbook.

/SHELLEXTENSION=(1|0)

Install or remove the Explorer’s context menu handler.

/ICONS=(1|0)

Install or remove all the shortcut icons.

/STARTMENUICON=(1|0)

Install or remove the start menu icon.

/DESKTOPICON=(1|0)

Install or remove the desktop icon.

/QUICKLAUNCHICON=(1|0)

Install or remove the quick launch icon.

/DISABLE USAGE TRACKING=(1|0)

Enable or disable the usage tracking mentioned above.

/D={Installation Folder}

Set the installation folder. It must be the last parameter used in the command line and must not contain any
quotes, even if the path contains spaces. Only absolute paths are supported. The destination folder must be
empty or contain a previous UltraDefrag installation.

Note

The shortcut icons force installation of the graphical interface they depend on.
The same way the context menu handler forces installation of the console interface.

The following samples illustrate use of the command line switches:

:: install everything except of desktop and quick launch icons
ultradefrag-7.0.0.bin.i386.exe /S /FULL=1 /ICONS=0 /STARTMENUICON=1

:: install the console and boot time interfaces only along with this handbook
ultradefrag-7.0.0.bin.i386.exe /S /MICRO=1 /HELP=1

:: remove the boot time interface from the previous installation
ultradefrag-7.0.0.bin.i386.exe /S /BOOT=0

:: change the installation folder
ultradefrag-7.0.0.bin.i386.exe /S /D=H:\Software\UltraDefrag

:: uninstall the program silently
%UD_INSTALL_DIR%\uninstall.exe /S

For troubleshooting omit the /S switch and check out dialogs to ensure that the installation parameters are adjusted
properly. In case of errors check out the following file as well: %TMP%\UltraDefrag_Install.log
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Graphical Interface

UltraDefrag GUI is pretty straightforward: you select disks and then either analyze, or defragment, or optimize them.
If multiple disks are selected they will be processed one by one. After the job completion you may open a file
fragmentation report to check out which files are still fragmented and why.

The program lists all disks available for defragmentation, marked by the following icons: - fixed drives, -
removable drives. Criss-crossed icons mark dirty ones. Click Action > Repair drives to clean ’em up.

To select multiple disks use the same rules as in Windows Explorer. For instance, hit Ctrl+A to select them all.

Double-click a drive or select it and hit Enter to start its analysis (repair if it’s a dirty one).

Cluster map

The bottom part of the window shows the cluster map of the selected disk. It represents disk clusters by little colored
squares. The top left square represents the first cluster, the bottom right - the last one. All the clusters in between
are organized by rows. The colors have the following meaning:

Fragmented Not fragmented Compressed
Directory Locked (system) MFT
Free space Unused map cell

Files and directories

When there are two different colors assigned to the same item, the darker one marks objects above the size
threshold, if one is set.

MFT

Dark magenta represents the master file table (MFT), light magenta - the space reserved for its expansion.

Unused map cells

Each cell reflects an integer number of clusters. So, for instance, if a disk has 1000 clusters, but its map
contains a bit more cells those redundand cells will be not used at all. On the other hand, if the map has exactly
2000 cells they will be all in use, reflecting 2 clusters each.

Note

Unused map cells are not to be confused with free space.

Free space color

The default is white as shown above, but it can be changed through a background color option.

http://support.microsoft.com/kb/174619
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It does make sense to set grid_line_width = 0 if you set map_block_size = 1 to use the screen space more
efficiently. This is especially useful, if you have drives bigger than 500GB in size. To set both options click Settings
> Options and edit the appropriate lines in the opened configuration file.

Menu

Action

Analyze (F5; Enter)

Analyze the selected disk(s).

Defragment (F6)

Defragment the selected disk(s).

Quick optimization (F7)

Perform quick optimization of the selected disk(s).

Full optimization (Ctrl+F7)

Perform full optimization of the selected disk(s).

Optimize MFT (Shift+F7)

Optimize the master file table on the selected disk(s).

Pause (Space)

Pause or resume the job. The current file movement will be completed to avoid data corruption.

Stop (Ctrl+C)

Abort the job. The current file movement will be completed to avoid data corruption.

Show report (F8)

Open the file fragmentation report for the selected disk(s).

Skip removable media (Ctrl+M)

Exclude removable drives from the list.
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Rescan drives (Ctrl+D)

Update the list of drives.

Repair drives

Repair the selected disk(s) using the chkdsk command line tool.

When done

Set the action to be performed after the job completion. The default is None, available actions are:
Exit, Standby, Hibernate, Logoff, Reboot and Shutdown.

Note

To shut the computer down successfully both your system and hardware configuration must support
shutdown and power off, otherwise Windows might either reboot the computer or simply stay idle.
The same way neither standby nor hibernation will work when they aren’t supported by the hardware
or aren’t turned on in Windows.

Exit (Alt+F4)

Terminate UltraDefrag.

Settings

Language

Select display language for the graphical interface.

Options (F10)

Open the main configuration file.

Sorting

Set sorting order for the disk optimization.

Boot time scan > Enable (F11)

Enable or disable the boot time processing (disabled in portable editions).

Boot time scan > Script (F12)

Open the boot time script (disabled in portable editions).
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Help

Contents (F1)

Open this handbook.

Best practice (F2)

Open the Tips and Tricks chapter of this handbook.

FAQ (F3)

Open the Frequently Asked Questions chapter of this handbook.

Cluster map legend

Show the Cluster map section of this chapter.

Debug

Get access to debugging information:

• Open log (Alt+L) opens a log file with debugging information if one is enabled.

• Send bug report opens the Troubleshooting chapter of this handbook.

Upgrade

Set whether the program will check for available updates on startup or not.

About (F4)

Show general information about the program.

Generated by Doxygen



Chapter 5

Console Interface

UltraDefrag command line (console) interface can be used to automate defragmentation via batch scripts and sched-
uled tasks. Also it can be used instead of the graphical interface by those who prefer command line environment.

Also UltraDefrag uses its command line interface to handle its context menu entries in Windows Explorer. Right
click any object and select Defragment with UltraDefrag to rejoin its clusters. To stop defragmentation hit Ctrl+C
or close the command prompt. To configure the context menu handler click Settings > Options in UltraDefrag GUI
or edit the following file manually: {installation folder}\conf\options.lua.

Note

The context menu handler is not available from the portable edition of the program.

UltraDefrag puts its command line tool to the %SystemRoot%\system32 folder, so it can be used without the full
path specification. Just make sure you run it from an elevated command prompt as it requires administrative
rights.

Usage:

udefrag [command] [options] [driveletter:] [path(s)]

Commands:

-a, --analyze

Analyze specified objects.

-o, --optimize

Perform full optimization.

-q, --quick-optimization

Perform quick optimization.

--optimize-mft

Optimize master file tables only.

-l, --list-available-volumes

List all fixed disks available for defragmentation.

-la, --list-available-volumes=all

List all available disks, including removable.

https://www.bleepingcomputer.com/tutorials/how-to-open-a-windows-10-elevated-command-prompt/
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-h, -?, --help

Display help.

Note

The commands are exclusive and can’t be combined with each other. If none is specified the program defrag-
ments selected objects.

Options:

-b, --use-system-color-scheme

Disable colorization of output.

-p, --suppress-progress-indicator

Hide the progress indicator and the cluster map.

-v, --show-volume-information

Show disk information after the job completion.

-m, --show-cluster-map

Show the cluster map.

--map-border-color=color

Set color of the cluster map border. Available colors: black, white, red, green, blue, yellow, magenta, cyan,
darkred, darkgreen, darkblue, darkyellow, darkmagenta, darkcyan, gray. Yellow is used by default.

--map-symbol=x

Set the character to draw the cluster map with. Type it directly or use its hexadecimal number (in range 0x1 ...
0xFF). For instance, use --map-symbol=0x1 to draw the map with a smile character. The % symbol is used by
default.

--map-rows=n

Set height of the cluster map. The default value is 10.

--map-symbols-per-line=n

Set width of the cluster map. The default value is 68.

--use-entire-window

Expand the cluster map to use the entire console window.

--wait

Wait for completion of other UltraDefrag instances before the job startup (useful for scheduled tasks).

--shellex

List selected objects and display a prompt to hit any key after the job completion. This switch is intended to
handle the context menu entries in Windows Explorer, so the program interpretes the options.lua file mentioned
above and ignores all the environment variables listed below.

Drive letters:

List of space separated drive letters or one of the following switches:
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--all

Process all available drives.

--all-fixed

Process all non-removable drives.

Paths:

List of space separated paths which need to be defragmented. Both absolute and relative paths are supported,
as well as wildcards: the question mark (?) matches any one character, while the asterisk (∗) - any zero or more
characters. Thus ∗.∗matches any file with an extension while a single asterisk (∗) matches anything (with or without
an extension). All paths including spaces must be enclosed by double quotes:

:: defragment drives d: and e:
udefrag d: e:

:: defragment the contents of the USERPROFILE folder
udefrag "%USERPROFILE%\*"

:: defragment everything inside of the ’..\Test Files’ folder
udefrag "..\Test Files\*"

:: defragment some individual file
udefrag C:\WINDOWS\WindowsUpdate.log

:: defragment them all at once
udefrag d: e: "%USERPROFILE%\*" "..\Test Files\*" C:\WINDOWS\WindowsUpdate.log

:: rejoin clusters of the WINDOWS folder
:: (its contents will be left untouched)
udefrag C:\WINDOWS

If command line is empty the program displays help.

Environment variables

Filter variables

UD IN FILTER

List of semicolon separated paths which need to be defragmented.
Empty list means that everything needs to be defragmented.

UD EX FILTER

List of semicolon separated paths which need to be skipped, i.e. left untouched.

UD FRAGMENT SIZE THRESHOLD

Eliminate only fragments smaller than specified.
The following size suffixes are accepted: KB, MB, GB, TB, PB, EB.

UD FILE SIZE THRESHOLD

Exclude all files larger than specified.
The following size suffixes are accepted: KB, MB, GB, TB, PB, EB.

UD OPTIMIZER FILE SIZE THRESHOLD

For optimization only, exclude all files larger than specified.
The following size suffixes are accepted: KB, MB, GB, TB, PB, EB.
The default value is 20MB.
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UD FRAGMENTS THRESHOLD

Exclude files having less fragments than specified.

UD SORTING

Set sorting criteria for the disk optimization. PATH is used by default, it forces to sort files by their paths.
Four more options are available: SIZE (sort by size), C_TIME (sort by creation time), M_TIME (sort by last
modification time) and A_TIME (sort by last access time).

UD SORTING ORDER

Set sorting order for the disk optimization. ASC (ascending) is used by default. DESC (descending) forces
to sort files in reverse order.

UD FRAGMENTATION THRESHOLD

Cancel all tasks except of the MFT optimization when the disk fragmentation level is below than specified.

Process variables

UD TIME LIMIT

Terminate the job automatically when the specified time interval elapses. The following time format is
accepted: Ay Bd Ch Dm Es. Here A,B,C,D,E represent integer numbers while y,d,h,m,s represent years,
days, hours, minutes and seconds.

UD REFRESH INTERVAL

The progress refresh interval, in milliseconds. The default value is 100.

UD DISABLE REPORTS

Set it to 1 (one) to disable generation of the file fragmentation reports.

Debugging variables

UD DBGPRINT LEVEL

Set amount of debugging output. NORMAL is used by default, DETAILED can be used to collect information
for a bug report, PARANOID turns on really huge amount of debugging information.

UD LOG FILE PATH

Set log file path (including file name) to redirect debugging output to a file.

UD DRY RUN

Set it to 1 (one) to avoid physical movements of files, i.e. to simulate the disk processing. This allows to
check out algorithms quickly.

Samples

Batch scripts can be used to automate complex defragmentation tasks:

@echo off

:: save debugging information for troubleshooting
set UD_LOG_FILE_PATH=C:\Windows\Temp\udefrag.log

:: terminate the processing after 6 hours and 30 minutes
set UD_TIME_LIMIT=6h 30m

:: exclude temporary stuff
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set UD_EX_FILTER=*system volume information*;*temp*;*tmp*;*recycle*

:: exclude archives as well
set UD_EX_FILTER=%UD_EX_FILTER%;*.zip;*.7z;*.rar

:: eliminate only fragments below 20 MB in size
set UD_FRAGMENT_SIZE_THRESHOLD=20MB

:: list all drives available for defragmentation
udefrag -la

:: check all available drives for errors
for /F "tokens=1 skip=8" %%D in (’udefrag -la’) do chkdsk %%D

:: analyze all fixed drives
udefrag -a --all-fixed

:: defragment everything on drive c:
udefrag c:

:: defragment small audio files on drive d:
set UD_IN_FILTER=*.mp3
set UD_FILE_SIZE_THRESHOLD=20MB
udefrag "D:\My Docs\Music\*"

:: defragment large video files having at least 10 fragments
set UD_IN_FILTER=*.avi;*.mkv
set UD_FILE_SIZE_THRESHOLD=
set UD_FRAGMENTS_THRESHOLD=10
udefrag "D:\My Docs\Movies\*"

:: optimize master file tables on drives c: and d:
udefrag --optimize-mft c: d:

:: reset filters used above
set UD_IN_FILTER=
set UD_FRAGMENTS_THRESHOLD=

:: sort files on drive g: by creation time in descending order
set UD_SORTING=C_TIME
set UD_SORTING_ORDER=DESC
udefrag -o g:

:: defragment drive h: only if its fragmentation level is above 10%
set UD_FRAGMENTATION_THRESHOLD=10
udefrag h:

:: defragment all fixed disks except of c:, d:, g: and h:
set UD_EX_FILTER=%UD_EX_FILTER%;C:\*;D:\*;G:\*;H:\*
udefrag --all-fixed

:: defragment a disk with no drive letter assigned,
:: mounted to C:\Games, using the diskpart utility

:: first of all, assign a drive letter to the disk
echo select volume c:\games > script
echo assign letter=t >> script
diskpart /s script

:: then, defragment the disk
udefrag t:

:: after all, remove the assigned letter
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echo select volume c:\games > script
echo remove letter=t >> script
diskpart /s script

:: hibernate the computer using a special
:: command line tool shipped with UltraDefrag
hibernate4win now

:: shut the computer down if hibernation failed
if errorlevel 1 shutdown -s -t 00
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Boot Time Defragmentation

To defragment files locked most of the time UltraDefrag can be launched inside of the Windows boot process. Being
executed there UltraDefrag can defragment almost everything including paging and hibernation files.

To enable the boot time defragmenter click Settings > Boot time scan > Enable in UltraDefrag GUI. To configure
it click the Script submenu or edit the following file manually: %SystemRoot%\system32\ud-boot-time.cmd.

The following command line tools can be used as well to control it: boot-on, boot-off and boot-config.

Being enabled the boot time defragmenter will run at every boot. However, you may skip its execution, just press any
key when the appropriate prompt will be shown on the screen. To stop any disk operations later hit Pause/Break.

Interactive mode

Hit Escape at any time to drop into an interactive console. It will show the following prompt on the screen and wait
for your input:

Interactive mode:
Type ’help’ to list available commands.
#

The same interactive console will be shown on the screen after the boot time script execution if the exit command
is missing there.

Available commands
; or #

Lines starting with one of these characters are treated as comments.

@

Lines starting with this character will be not shown on the screen.

boot-on

Turns the boot time defragmenter on for the next boots.

boot-off

Turns the boot time defragmenter off for the next boots.

call

Similar to the DOS command. Executes a script; if none is specified the main boot time script will be executed.
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echo

Similar to the DOS command. Displays a message, an empty line, sets whether the commands will be shown
on the screen or not or displays the current setting.

exit

Similar to the DOS command. Terminates UltraDefrag.

help

Lists all available commands.

hexview

Displays a file in a HEX viewer layout:

000000C0: 0a 00 3b 00 20 00 46 00 | ; F
000000C8: 72 00 61 00 67 00 6d 00 | r a g m
000000D0: 65 00 6e 00 74 00 65 00 | e n t e

history

Lists all manually entered commands. To cycle through them use the up/down arrow/cursor keys.

man

Lists or displays available manual pages.

pause

Pauses the script execution for the specified time interval (in milliseconds) or till a key is pressed if no duration
is specified. For example, the command pause 1000 will pause execution for one second.

reboot

Reboots the computer.

set

Similar to the DOS command. Lists, sets and clears environment variables.

shutdown

Shuts the computer down.

type

Similar to the DOS command. Displays a file; if none is specified the main boot time script will be shown.

udefrag

The boot time equivalent of the Console Interface. Accepts the following command line switches: -l, -la, -a, -o,
-q, --optimize-mft, --all, --all-fixed. To process single files or directories specify their absolute paths. If they
include spaces enclose them by double quotes:

udefrag "C:\Documents and Settings\*" C:\WINDOWS\WindowsUpdate.log

All commands displaying long lists (help, hexview, history, man, set, type) are splitting them into pages in the
interactive mode.
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Environment variables

Environment variables can be used the same way as in Windows batch files.

Two special variables are supported: DATE for the current date in the format YYYY-MM-DD and TIME for the
current time in the format HH-MM:

2012-02-14
12-48

Restrictions

Encrypted disks cannot be defragmented at boot time because the local security service is inactive on
early stages of Windows boot.

UltraDefrag terminates immediately in Windows safe mode because it cannot display text on the screen there.

Script samples

By default the program defragments the Windows folder, registry hives, paging and hibernation files using the
following script:

@echo off
;------------------------------------------------------------------------------
; UltraDefrag Boot Time Shell Script
;------------------------------------------------------------------------------
; !!! NOTE: THIS FILE MUST BE SAVED IN UNICODE (UTF-16) ENCODING !!!
;------------------------------------------------------------------------------

set UD_IN_FILTER=*windows*;*winnt*;*ntuser*;*pagefile.sys;*hiberfil.sys
set UD_EX_FILTER=*temp*;*tmp*;*dllcache*;*ServicePackFiles*

; exclude big fragments which rarely benefit from defragmentation
set UD_FRAGMENT_SIZE_THRESHOLD=20MB

; if your system drive is an SSD uncomment the following
; line to exclude slightly fragmented content as well
; set UD_FRAGMENTS_THRESHOLD=20

; uncomment the following line to increase amount of debugging output
; set UD_DBGPRINT_LEVEL=DETAILED

; uncomment the following line to save debugging information to a log file
; set UD_LOG_FILE_PATH=%UD_INSTALL_DIR%\logs\ud-boot-time.log

udefrag %SystemDrive%

boot-off

exit

The next script utilizes special environment variables mentioned above:

; create a timestamped log file
set UD_LOG_FILE_PATH=%UD_INSTALL_DIR%\logs\ud-boot-time-%DATE%-%TIME%.log

udefrag %SystemDrive%

exit
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Chapter 7

Scheduled Defragmentation

To set scheduled defragmentation up use Windows Task Scheduler:

:: defragment Firefox cache
udefrag "%APPDATA%\Mozilla*"

:: defragment Google Earth cache
udefrag "%APPDATA%\Google\GoogleEarth*"

:: defragment small files on all non-removable disks
cmd.exe /C "set UD_SIZELIMIT=100MB && udefrag --wait --all-fixed"

Visit UltraDefrag Wiki for more information.

https://en.wikipedia.org/wiki/Task_Scheduler
https://sourceforge.net/p/ultradefrag/wiki/Home/
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Chapter 8

File Fragmentation Reports

After the job completion the program creates a file fragmentation report. It contains the following information about
fragmented files:

Fragments

Number of fragments.

Filesize

Size of the file.

Comment

[DIR] for directories and [CMP] for NTFS compressed files.

Status

The reason the file is still fragmented: either locked or move failed or invalid. In the last case the disk needs to
be checked for errors (run CHKDSK {Driveletter} /F /R to fix it). If no reason is specified the file simply requires
more continuous free space for defragmentation.

Filename

The full path of the file.

To open the report click Action > Show report in UltraDefrag GUI or click the following file in Windows Explorer:
{installation folder}\reports\fraglist_{drive}.luar. Depending on configuration the program will generate either a
web page or a plain text report and show it then.

To configure the reports click Settings > Options in UltraDefrag GUI or edit the following file manually: {installation
folder}\conf\options.lua.

By default files are sorted by number of fragments in descending order. To change the order click the appropriate
column heading. The sorting is pretty slow: it may take a few seconds.
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Tips and Tricks

Performance

How to improve system performance significantly

The best way to improve system performance is to buy new hardware. Traditional hard disk drives have a lot
of mechanical parts inside which have to move to and fro whenever you read something from the disk or write
something to it. All the movements take significant amount of time and nothing can be done to eliminate these extra
costs completely. On the other hand, all the top performance hard disk drives built recently have no mechanical
parts inside at all. They store information in memory chips instead and that’s why they are called solid state
drives (SSD). As they have no need to perform any physical movements they are much faster than the traditional
drives and the only drawback is that they are still much more expensive. However, if you really need top performance,
it’s the only choice for you. Additionally, you get significantly reduced power consumption, higher robustness and
completely silent operation. You may still use traditional drives for data more tolerant for slower access, but for
system files we highly recommend to use an SSD.

Then we recommend to disable the Windows paging file. It expands RAM, but works much slower, no
matter whether you place it on an SSD or not. If you need more memory than physically installed, buy more for the
best performance.

And, after all, if you’re still using a traditional drive and would like to keep some files closer to its beginning because
of higher speed of that area, don’t ask disk defragmenters for it: just repartition the disk once and then use
the first partition to keep the most frequently accessed files while the second one - for backups, videos, music and
other stuff more tolerant for slower access.

How frequently to defragment

Defragment files whenever you believe their fragmentation slows down your system. It really does make sense to
defragment the system drive from time to time and optimize it after massive updates. On the other hand, data drives
rarely benefit from defragmentation, especially when they are filled by music and videos.

In case of highly fragmented drives, no matter what is fragmented, files or free space, we recommend to run the full
optimization instead of regular defragmentation as it usually leads to better results. If neither defragmentation nor
optimization are able to reduce fragmentation significantly in most cases it simply means you haven’t enough free
space on the disk, so it’s time for a cleanup.

The best environment for UltraDefrag

The program shows the best performance being launched at Windows boot where no concurrent processes are
running. Nothing interrupts its flow and no applications are locking files preventing their movements.

On the other hand, when your system is in use, some files, being locked by running applications, drop down Ultra-
Defrag performance. Due to this reason we recommend to optimize entire disks at Windows boot rather than on a

https://en.wikipedia.org/wiki/Solid-state_drive
https://en.wikipedia.org/wiki/Solid-state_drive
https://en.wikipedia.org/wiki/Paging#Windows_NT
http://gparted.sourceforge.net/
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fully running system. Slightly better results can be achieved in Windows safe mode, but at boot they’re always the
best.

Note

You should disable your virus detection software before defragmentation, because otherwise it will be extremely
slow. If your antivirus program allows to exclude processes from being monitored, you might exclude Ultra-
Defrag instead of disabling it completely.

Regardless of environment remove temporary contents from disks before their optimization. This will shorten opti-
mization time and lead to better results.

Hardware

Flash and SSD drives

Defragmentation of flash memory and solid state drives (SSD) is usually not necessary as those
drives don’t rely on physical movements of mechanical parts anyway. However, in case of heavily fragmented files
defragmentation still does make sense as it improves performance of the file system itself. Also defragmentation
can help to make files more recoverable.

Floppy drives

Floppy drives defragmentation is not recommended, because it always reduces lifespan of the floppies.

Checking the file system

Freshly used drives can be defragmented immediately; any drive, which has been in use for a long time without
maintenance, should be checked for consistency first. Open a command prompt and type one of the following
commands there:

:: check drive c: and repair it when needed
chkdsk C: /F /V

:: check drive c:, repair it and collect lost clusters
:: when needed (takes quite long, but is the safest)
chkdsk C: /R /F /V

Parallel processing

Simultaneous defragmentation of multiple hard disks can save time.

For instance:

• Hard disk 1 contains partitions C: and D:

• Hard disk 2 contains partitions G: and H:

Start two UltraDefrag sessions simultaneously - one for partitions C: and D: and another one for G: and H: to save
up to 50% of time (compared to the case when all four partitions are processed one by one). On the other hand,
don’t try to defragment partitions C: and D: simultaneously - they belong to the same physical disk, so their parallel
processing will be pretty slow.

Generated by Doxygen

https://en.wikipedia.org/wiki/Flash_memory
https://en.wikipedia.org/wiki/Solid-state_drive
https://sourceforge.net/p/ultradefrag/discussion/709672/thread/7f71fff6


27

Caveats

How to prevent endless boot processing

We are trying to keep the program as reliable as possible, but some little chance still exists that its boot time interface
will crash making it impossible to boot into Windows. So, for extra safety we recommend to automatically turn the
program off for subsequent boots by inclusion of the boot-off command to the beginning of the boot time script.

USN journal cleanup

Sometimes a fragmented USN journal prevents free space consolidation. Open an elevated command
prompt and type the following commands there to clean it up:

:: query the journal parameters,
:: write them down to use later
fsutil usn queryjournal c:

:: delete the journal
fsutil usn deletejournal /n c:

:: now it’s time to optimize the disk...

:: recreate the journal afterwards
fsutil usn createjournal m=33554432 a=4194304 c:

A reasonable value for the maximum size is 85MB for each 100GB of the disk space. The allocation delta should
be between 1/8 and 1/4 of the maximum size. The default values are usually 32MB and 4MB respectively.

Generated by Doxygen

http://technet.microsoft.com/en-us/library/cc788042.aspx
https://www.bleepingcomputer.com/tutorials/how-to-open-a-windows-10-elevated-command-prompt/
https://www.bleepingcomputer.com/tutorials/how-to-open-a-windows-10-elevated-command-prompt/


28 Tips and Tricks

Generated by Doxygen



Chapter 10

Frequently Asked Questions

Installation

How can I find out which installer to download?

1. open the Run dialog by hitting [Windows]+R

2. type cmd.exe /K echo %PROCESSOR_ARCHITECTURE% and then click OK

3. check out the top-left corner of the opened command prompt window

• If it shows x86 download the i386 installer.

• If it shows AMD64 download the amd64 installer.

• If it shows IA64 download the ia64 installer.

Can I up- or downgrade over an existing installation?

Yes. There’s no need to remove old files, the installer will take care about everything automatically.

My antivirus software says UltraDefrag is infected by a virus. Is it true?

UltraDefrag is open source software, so it cannot contain malicious stuff by definition. For extra safety, to ensure
that the compiled binaries haven’t been accidentally infected, we test them all carefully on virustotal.com.
Only when all files pass most of the virus scanners we make an official release. So, if you see a message saying
UltraDefrag is infected by a virus, actually that’s nothing but a false positive. We do recommend you to
report the case to your antivirus software vendor. As a result your antivirus software will get fixed and you won’t see
the false positives anymore.

General usage

I need to defragment a large file but have no sufficient free space gap on the disk, what should I do?

To consolidate free space you can try the full optimization. If it fails to achieve the desired result try one of the
following:

• Move all files to another disk, reformat the original disk and move files back. Everything will be perfectly
settled in the beginning of the disk.

• Use GParted or Partition Magic software to shrink the disk. Then expand it back to the original size
to get a continuous free space gap at the end.

https://www.virustotal.com/
https://en.wikipedia.org/wiki/False_positives_and_false_negatives
http://gparted.sourceforge.net/
https://en.wikipedia.org/wiki/PartitionMagic
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After defragmentation I see my restore points disappeared, what happens?

The system restore service sometimes tracks file movements. When it exhausts all the disk space reserved for
restore points it eliminates elder stuff to release some space for further tracking. Due to this reason we recommend
to use backup software instead to keep valuable data backed up.

How to move everything to the beginning of the disk?

Usually it doesn’t make sense to move big fragments, but if you’d like to get all files perfectly sorted or just want to
pack everything as tight as possible before partition shrinking you can easily do it. Just set the fragment_size_-
threshold parameter to 0, the optimizer_file_size_threshold parameter to 15 EB and unset all filters. This way
UltraDefrag will move all files, regardless of their fragments size, to the beginning of the disk.

I have a volume with no drive letter assigned, how can I defragment it?

Go to Start > Control Panel > Administrative Tools > Computer Management > Storage > Disk Manage-
ment and assign a drive letter to the volume. Then defragment it and, if you wish, remove the assigned letter
afterwards. To automate the process the diskpart utility can be used as shown in the Console Interface chapter
of this handbook. The only drawback is that in some cases a reboot may be required to release the assigned drive
letter, especially on older systems like Windows XP.

Graphical interface

When will the cluster map become interactive, so I’ll be able to know where individual files are located on disk?

When defragmentation algorithms are quite efficient, it’s definitely not necessary to know locations of individual files
- anyway you’ll get your drive optimized quite well. Maybe we’ll implement the discussed feature later, but now it’s
time for more significant improvements.

Why configuration files are better than one settings window with tabs?

Configuration files are easy to edit, even in Windows Notepad.

Why the progress percentage updates irregularly?

The progress percentage measures disk space, not number of files. So it advances pretty quickly when the program
deals with big files, and slows down significantly when thousands of small files are in the queue.

Why the progress sometimes exceeds 100% for FAT disks?

On FAT disks space gets immediately released after file movements, so it might happen that more files get fully
defragmented than initially calculated.

Why is the disk name not displayed?

Windows Explorer replaces empty disk names by Local Disk or similar, but UltraDefrag doesn’t.

Why is only the last report displayed, if I choose to display multiple reports?

Browsers which do not support tabbed browsing are reusing the same window. This is a limitation of the way a web
page is opened from within Explorer.
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Why are multiple windows opened, if I choose to display multiple reports?

If your browser supports tabbed browsing open one instance of it before you display the reports. This will open each
report in a new tab depending on your browser configuration.

When I click Settings > Options the program fails to open the options.lua file, what’s going on?

Usually it happens on 64-bit systems when a 32-bit text editior is associated with the .lua file extension. To fix the
problem just install a 64-bit edition of the editor or associate the .lua extension with the built-in Windows Notepad.

Boot time interface

Why some files are still fragmented?

Inspect the file fragmentation reports to find out the reason. Some system configurations are locking files even at
boot, which can’t be prevented. In some cases free space regions aren’t big enough to hold the entire file. You
might fix that using the quick optimization which consolidates free space a bit.

How can I disable the boot time defragmenter manually?

Remove the defrag_native entry from the following system registry parameter:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\BootExecute

Miscellaneous

How many differences are between the disk processing algorithms of UltraDefrag and well known MyDefrag (previously JkDefrag)?

Both programs have similar disk analysis algorithms, but defragmentation is done in different ways. While MyDefrag
gives more control over files placement, UltraDefrag uses much simpler algorithms which are faster and easier to
use.
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Chapter 11

Troubleshooting

If something went wrong don’t hesitate to investigate the case and report it via our bug tracker.

To help us find out what’s going on please attach UltraDefrag debugging output to your report.

To catch it directly use the Debug View program: its Capture Win32 feature suits well for the purpose.

To redirect the debugging output to a log file use the following commands for the console and boot time interfaces

set UD_DBGPRINT_LEVEL=DETAILED
set UD_LOG_FILE_PATH=%UD_INSTALL_DIR%\logs\udefrag.log

or simply adjust the GUI parameters dbgprint_level and log_file_path.

Note

If logging to the specified file fails the program tries to log into the %SystemDrive%\UltraDefrag_Logs folder.

For graphical interface issues please attach also a screenshot.

To speed things up compress logs by 7-zip and save screenshots in png format before their submission to the
bug tracker.

https://sourceforge.net/p/ultradefrag/bugs/
http://technet.microsoft.com/en-us/sysinternals/bb896647.aspx
https://en.wikipedia.org/wiki/Screenshot
https://sourceforge.net/projects/sevenzip/
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Translation

UltraDefrag uses Transifex to manage translations online. Register there for free to join our team. You are
welcome!

If you’d like to translate the program offline use the PoEdit software.

To configure PoEdit enter your name and email address under File > Preferences > Personalise > Identity.

To edit an existing translation find your language in the ISO 639-2 list and edit then the appropriate {installation
folder}\po\{language code}.po file.

To create a new translation click File > New catalogue from POT file and select {installation folder}\po\Ultra-
Defrag.pot as the translation template.

Enter the following information into the catalog properties dialog:

• Project name and version: ultradefrag

• Language: the language code mentioned above

• Charset: UTF-8

• Plural forms: fill it if you know how

Translate strings paying attention to the Notes for translators and then send the updated stuff to us.

Your changes will be applied to the next release of UltraDefrag.

https://www.transifex.com/projects/p/ultradefrag/resource/main/
http://www.poedit.net/
http://www.loc.gov/standards/iso639-2/php/code_list.php
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Chapter 13

Development

If you’d like to know what’s under the hood you are welcome to inspect UltraDefrag sources. You can either use an
online svn browser or download sources from SourceForge. Alternatively you can setup an SVN client
(for instance TortoiseSVN) and check sources out from their base address.

Essential parts of UltraDefrag are written in four programming languages:

UltraDefrag core libraries are written in pure C for compatibility with Windows boot environment where
only primitive ntdll interfaces are available. Both graphical and command line tools are written in C++ on top of
wxWidgets library which helps to keep things simple. For configuration purposes and reports generation the
program uses the Lua scripting language. UltraDefrag installers are written in NSIS.

Compilation

First of all, to build the program download and unpack its sources somewhere. Make sure the path doesn’t contain
spaces (GNU make doesn’t like them). Then install the following software:

• MinGW, wxWidgets 3.1.0, Doxygen 1.8.4, NSIS 2.xx, 7-zip

• Lua 5.1.x, UPX (extract them somewhere on your %path%)

• Transifex client (put it to \src\tools\transifex folder)

• GNU gettext (optional; for translations management)

• MiKTeX (optional; for pdf documentation; use basic installer)

To build 64-bit packages install also Microsoft Windows SDK v7.1.

To configure build environment follow these steps:

https://sourceforge.net/p/ultradefrag/code/
https://sourceforge.net/projects/ultradefrag/files/
http://tortoisesvn.net/
https://svn.code.sf.net/p/ultradefrag/code/
http://www.openhub.net/p/ultradefrag
https://ultradefrag.net/doc/lib/
http://www.wxwidgets.org/
http://www.lua.org/
http://nsis.sourceforge.net/
http://stackoverflow.com/questions/9838384/can-gnu-make-handle-filenames-with-spaces
http://sourceforge.net/projects/tdm-gcc/
http://github.com/wxWidgets/wxWidgets/releases/download/v3.1.0/wxWidgets-3.1.0.7z
http://www.doxygen.org/
http://nsis.sourceforge.net/
http://www.7-zip.org/
http://luabinaries.luaforge.net/
http://upx.sf.net/
http://help.transifex.com/features/client/index.html#windows-version
http://sourceforge.net/projects/gnuwin32/files/gettext/
http://www.miktex.org/
http://www.microsoft.com/en-us/download/details.aspx?id=8442
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:: edit the main configuration file
edit setvars.cmd

:: patch the installed software
patch-tools

:: build wxWidgets using all the compilers
:: involved in development
wxbuild --use-mingw
wxbuild --use-winsdk

To build UltraDefrag use the following commands:

:: build the program using defaults
build

:: show all available options
build --help

:: use predefined build actions
build-menu

If you need an IDE for development install Code::Blocks as well. To launch it in correct environment type:

start-CodeBlocks

If you’d like to know how the build process works inspect .cmd files - they contain the complete information.

Web resources

Follow these links to understand better UltraDefrag design and internals.

Batch scripting

Hidden features of Windows batch files

Windows command line syntax

Rob van der Woude’s scripting pages

Binary trees

The Art of Computer Programming

Boot time interface

Windows native API reference

Windows x86 system call table

Defragmentation

Inside Windows NT disk defragmenting

Improvements in Windows 7
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http://j00ru.vexillium.org/ntapi/
https://ultradefrag.net/doc/man/Inside Windows NT Disk Defragmenting.pdf
http://blogs.msdn.com/b/e7/archive/2009/01/25/disk-defragmentation-background-and-engineering-the-windows-7-improvements.aspx
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Improvements in Windows XP

Defragmenting Files (Windows)

Master File Table (Windows)

File systems

NTFS on-disk structure

Graphical interface

Design apps for the Windows desktop

Writing High-DPI Win32 Applications

Software design

The Art of Unix Programming

GNU coding standards

Information for maintainers of GNU software

Threads

Writing reentrant and threadsafe code

A short guide to mastering thread-safety
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https://ultradefrag.net/doc/man/ntfs/
http://msdn.microsoft.com/en-us/library/aa511258.aspx
http://msdn.microsoft.com/en-us/library/dd464659(VS.85).aspx
http://www.faqs.org/docs/artu/
http://www.gnu.org/prep/standards/
http://www.gnu.org/prep/maintain/
http://www-01.ibm.com/support/knowledgecenter/ssw_aix_61/com.ibm.aix.genprogc/writing_reentrant_thread_safe_code.htm%23writing_reentrant_thread_safe_co?cp=ssw_aix_61%2F13-3-12-18
http://www.thinkingparallel.com/2006/10/15/a-short-guide-to-mastering-thread-safety/
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Credits and License

Program and Documentation Copyright ©2007-2008

• Dmitri Arkhangelski <dmitriar@users.sourceforge.net>

• Justin Dearing <zippy1981@users.sourceforge.net>

Program and Documentation Copyright ©2009, 2015-2018

• Dmitri Arkhangelski <dmitriar@users.sourceforge.net>

Program and Documentation Copyright ©2010-2014

• Dmitri Arkhangelski <dmitriar@users.sourceforge.net>

• Stefan Pendl <stefanpe@users.sourceforge.net>

Web Design Copyright ©2009, 2011

• Sayem Chaklader <gearspec@gmail.com>

Translations Copyright ©2008-2018

• Albanian - Fitim I. Halili
- Skender Mustafi

• Arabic - Ahmed Arbaoui
- Awadh A Al-Ghaamdi

• Armenian - MrEgho
• Belarusian - Dmitri Arkhangelski
• Bengali - Sayem Chaklader
• Bosanski - Timur Ljubunčić
• Bulgarian - Dmitri Arkhangelski

- Georgi Dimov
• Burmese (Padauk) - Muhammed Widuya

- Pyae Sone
• Catalan - Illes Balears

- Joseph S. Maza
- jmontane

• Chinese (Simplified) - muzuiget
- HPJ
- Tommy He
- Elita Alutee
- All UltraDefrag Fans

mailto:dmitriar@users.sourceforge.net
mailto:zippy1981@users.sourceforge.net
mailto:dmitriar@users.sourceforge.net
mailto:dmitriar@users.sourceforge.net
mailto:stefanpe@users.sourceforge.net
mailto:gearspec@gmail.com
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- wwj402
- Y.F. Yang

• Chinese (Traditional) - muzuiget
- Ryan Ping Chih Ko
- rexx
- James Bond
- PasserBy

• Croatian - Denis Jeličić
- Dmitri Arkhangelski
- Mladen Ivošević
- streger

• Czech - David Horák /Dave MacBlack/
- Pavel Kinkor
- Jiří Vírava

• Danish - Patrick Paludan-Müller
- Jens Erik Graversgaard
- Jens Hyllegaard

• Dutch - Wim Kerstens
- Klaas Nekeman
- Tom Louwrier
- Evert Blankestijn

• English (GB) - Andrew Smith
• English (US) - Dmitri Arkhangelski
• Estonian - Olav Mägi

- Tiit Pääsukene
- Joosep-Georg Järvemaa

• Farsi - Ali Jafari
- SBL

• Filipino (Tagalog) - Joseph S. Maza
- Ezekiel JB Vegiga

• Finnish - jtl
- Jukka Laari

• French - Pascal Crozet
- Jérôme Blum
- Mathieu Van Weersch
- Marina Louwrier-Johannsen
- Thomas Laroche
- William Gathoye
- Marc Sokolovitch
- yahoe.001

• Galician - Julio Mojón Fuentes
- pep

• Georgian - UGLT.org
• German - Stefan Geuken

- Stefan Pendl
• Greek - Konstantinos Kapoukranidis

- Dionisios Klonaris
- Wasilis Mandratzis

• Hebrew - Dmitri Arkhangelski
• Hindi - Gaurav Chatterjee

- Utkarsh Ray
• Hungarian - Nagy Zsolt

- Áron Hegedüs
- Gellért Lukács
- Brechler Zsolt
- Attila Kalmár

• Icelandic - Stefan Pendl
• Iloko - Joseph S. Maza
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• Indonesian (Bahasa Indonesia) - Taufan Nur Hidayat
- Djati Satria

• Indonesian - Imanuel Novian
- Djati Satria
- Rizki Aulia Rachman
- Joshua Randiny

• Italian - Paolo Loggia
- Sherpya
- Edoardo Brunetti
- Alessandro Visentin
- Giacomo Margarito
- eagleman

• Japanese - ao3
- Masao Kajiwara
- kako
- Michael Robert Lawrence
- Tatsuya Mizushima (MCtek)

• Javanese - Taufan Nur Hidayat
• Kapampangan - Edwin N. Camaya
• Korean - Alex Han

- Inhwan Hwang
- Zames Dean

• Latin - Dmitri Arkhangelski
• Latvian - Sevelyr

- Vladislav Stuznev
- Raitis Nugumanovs

• Lithuanian - Eugenijus Januškevičius
- Laurynas

• Macedonian - Dmitri Arkhangelski
• Norwegian - Sveinung Heggen

- Stefan Pendl
• Polish - Andrzej Rudnik

- Ireneusz Chorosz
- Mateusz Kacprzak
- CWK

• Portuguese (BR) - Depeo da Masol
- Felipe
- Rafael Ferreira

• Portuguese - Ricardo A. Garcia
- Carlos Rodrigues
- Sérgio Marques

• Romanian - Micu (BeBe) Dumitru
• Russian - Dmitri Arkhangelski

- Raitis Nugumanovs
• Serbian - Damjan Daljevic

- Dmitri Arkhangelski
• Slovak - Milan Cerovský

- Jajo Pajo
• Slovenian - Miha Mlakar

- Dmitri Arkhangelski
• Spanish (AR) - Daniel Testa
• Spanish (ES) - Txusti

- Juan C. Mendez Valledor
- Javier Contreras
- NetVicious
- Joseph S. Maza
- strel

• Spanish (MEX) - Conrad Flyckt
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- Felipe Ángel González Báñez
- Joseph S. Maza
- Francisco Ortega Olivos

• Swedish - Magnus Rostedt
- Per-Eric Jenshagen
- Christoffer Ekberg
- JacobVF

• Tamil - Vinod V.
• Thai - Pat Taweewat

- Thanapon Namjittrong
• Turkish - Huseyin Kozan

- Vedat Odabasioglu
- Şahin Salincakli
- Alper Tiryakioglu
- yakup

• Ukrainian - Dmitri Arkhangelski
- lembergman
- alex hap
- zubr139

• Uzbek (Latin) - Sherzod Mamatkulov
• Vietnamese - Vietnamize Team

- DT
- Anh Phan

• Wáray-Wáray - Harvey Fiji
- Voltaire Oyzon
- Joseph S. Maza

• Yiddish - Dmitri Arkhangelski

All the translations are licensed under the Creative Commons Attribution 3.0 License.

Portions Copyright ©

UltraDefrag includes portions of the following open source software:

• wxWidgets

Portions Copyright ©1998-2005 Julian Smart, Robert Roebling et al

This library is licensed under the terms of the wxWindows Library Licence.

• Lua

Portions Copyright ©1994-2007 Lua.org, PUC-Rio

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTIO-
N OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

• GNU libavl

Portions Copyright ©1998, 1999, 2000, 2001, 2002, 2004 Free Software Foundation, Inc.

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser
General Public License as published by the Free Software Foundation; either version 3 of the License, or (at
your option) any later version.
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This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this program; if not,
write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

UltraDefrag GUI includes icons made by third-party developers.

The glass icon has been copied from the NSIS compiler’s frontend.

• Portions Copyright ©2002 Robert Rainwater <rrainwater@yahoo.com>

This software is provided ’as-is’, without any express or implied warranty. In no event will the authors be held
liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and
to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original
software. If you use this software in a product, an acknowledgment in the product documentation would
be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the
original software.

3. This notice may not be removed or altered from any source distribution.

The table and stop icons have been copied from the FamFamFam Silk icon set.

• Portions Copyright ©2006 Mark James

This work is licensed under the Creative Commons Attribution 2.5 License.

The icons can also be used under the Creative Commons Attribution 3.0 License with the
following requirements:

As an author, I would appreciate a reference to my authorship of the Silk icon set contents within a readme
file or equivalent documentation for the software which includes the set or a subset of the icons contained
within.

The Lua and Lua Report icons are based on the artwork by Alexandre Nakonechnyj.

• Portions Copyright ©1998 Lua.org. Graphic design by Alexandre Nakonechnyj.

Permission is hereby granted, without written agreement and without license or royalty fees, to use, copy, and
distribute this logo for any purpose, including commercial applications, subject to the following conditions:

– The origin of this logo must not be misrepresented; you must not claim that you drew the original logo.

– The only modification you can make is to adapt the orbiting text to your product name.

– The logo can be used in any scale as long as the relative proportions of its elements are maintained.

The taskbar overlay icon is based on the Fugue icon set. Also the following icons have been copied from it: pause,
gear, terminal, script, help, light bulb, star and large stop.

• Portions Copyright ©2012 Yusuke Kamiyamane

These icons are licensed under the Creative Commons Attribution 3.0 License.

The UltraDefrag debugger’s icon is based on Mozilla Crash Reporter’s icon licensed under Mozilla Public
License 2.0.
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Special thanks for porting UltraDefrag to Linux are going to:

• Jean-Pierre André <jean-pierre.andre@wanadoo.fr>

Special thanks for contributions:

• Tiago Filipe Silva - Optimized web images and udsorting.js script.

Special thanks for good ideas (in alphabetical order):

• Alexander Peter Kowalski - Process priority control (not implemented yet).
• Alexander Vedyakin - Disk type detection improvements.

More efficient defragmentation algorithms.
• Andrei Maksimov - GUI improvements.

A lot of other interesting ideas.
• Brian Gaff - More comfortable GUI design.
• Bryan Kirk - Better GUI appearance (new list of drives).

Autodefrag feature (not implemented yet).
• Christopher Naegel - A fix for kernel mode driver loading problem on Vista.
• Craig Oakes - Hint about case mismatched names of help files.

Hint about incorrect registration of .lua extension.
• Dario Raparelli - Windows NT 4.0 support.
• Gan Yau Kuang - Drives repair GUI menu.
• Jan Loncik - x64 native support. Better default values for filters.
• Jim Laski - System fonts and visual styles for graphical interface.
• Joachim Otahal - Disk processing algorithms optimization.
• Justin Dearing - Boot time defragmentation.
• Kalle Koseck - Disk analysis speedup. GUI improvements.
• Kerem Gümrükcü - Manifests for Vista User Account Control (UAC).
• Leland G. Whitlock - More efficient defragmentation algorithms.

Progress bar (not implemented yet).
• Markus Elfring - Strong error handling.
• Mike Braca - Cluster map implementation consuming less memory.
• Nagy Zsolt - Internationalization support. Installer improvements.
• Parvez Reza - Various interesting programming tricks.
• Steve Lawrence - Shutdown when done option.
• Vasily Smirnov - FAT directories defragmentation algorithm.

Various important GUI improvements.

Special thanks for translation updates and corrections (in alphabetical order):

Aivier, Andi Chandler, Antonio Vivace, Benny Stütz, Bernard Ladenthin, Carlo Bruschi, Catur Susetyo, Connec-
tion, credofashion, Dandy Cheung, Daniel Rodríguez, Davide, Dmitry Zemskov, Erwin Dokter, El Fiera, Fabrizio
Marana, FS, Garoiu Victor, Giulio Fornasar, Gustavo Rezende, Haein Jung, Harald Arnesen, Jan Iemhoff, Jani
Kinnunen, JIFF, Julien Chartier, Luigi C., Javier Valdivieso, Jiri Sedlak, José Carlos Taveira de Souza, José
Luis Farías, Karam Al-Shorbassi, Ken Choy, Krzysztof Świderski, Latino, Leo Smulders, luigif, Łukasz Choj-
nacki, MAFA1005, Massa, Matej Marton, Mateusz Krawczyk, Nikolay Parukhin, Patrick Palm, Piotr Halama,
Ralf Boening, Reynald Didier, Robert Jr, Robert Readman, Rodrigo Lopes Paitach, Seph, SMHA, Suranappar.-
se, Timo VJ Lähde, Tjeerd van Sas, Trans-fr, translucens, TurboHz, udef-jardic, Zirikkanen

Special thanks for extensive testing (in alphabetical order):

Andrei Maksimov, Bear Windows, Brent Jenkins, Fred Schall, Jeff Cubillos, Kalle Koseck, Kerem Gümrükcü,
Leslie Trenholm, Markus Elfring, Nagy Zsolt, Sachin Kunjikoran, Stefan Pendl, Tom Arroyo
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Also special thanks are going to:

• Mark Russinovich
• Vyacheslav Soldatov
• blume1975
• ReactOS Team
• NSIS developers
• UPX developers
• MinGW Team
• Alexander A. Telyatnikov
• Mumtaz Zaheer
• Giovanni Di Sirio
• James Brown
• Timo VJ Lähde
• Lokesh Dhakar
• Mark James
• Michael Dunn
• Michael Kaplan

Also many thanks to all the people who helped us to improve UltraDefrag.

This documentation is licensed under the terms of the GNU Free Documentation License.

The program is licensed under the terms of the GNU General Public License.

14.1 GNU Lesser General Public License

Version 3, 29 June 2007

Copyright (C) 1991 Free Software Foundation, Inc.
51 Franklin St, Fifth Floor, Boston, MA 02110-1301, USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the
GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, “this License” refers to version 3 of the GNU Lesser General Public License, and the “GNU GPL”
refers to version 3 of the GNU General Public License.

“The Library” refers to a covered work governed by this License, other than an Application or a Combined Work as
defined below.

An “Application” is any work that makes use of an interface provided by the Library, but which is not otherwise
based on the Library. Defining a subclass of a class defined by the Library is deemed a mode of using an interface
provided by the Library.

A “Combined Work” is a work produced by combining or linking an Application with the Library. The particular
version of the Library with which the Combined Work was made is also called the “Linked Version”.

The “Minimal Corresponding Source” for a Combined Work means the Corresponding Source for the Combined
Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the
Application, and not on the Linked Version.

The “Corresponding Application Code” for a Combined Work means the object code and/or source code for the
Application, including any data and utility programs needed for reproducing the Combined Work from the Application,
but excluding the System Libraries of the Combined Work.
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1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the
GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by
an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may
convey a copy of the modified version:

• a) under this License, provided that you make a good faith effort to ensure that, in the event an Application
does not supply the function or data, the facility still operates, and performs whatever part of its purpose
remains meaningful, or

• b) under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the Library. You
may convey such object code under terms of your choice, provided that, if the incorporated material is not limited
to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten
or fewer lines in length), you do both of the following:

• a) Give prominent notice with each copy of the object code that the Library is used in it and that the Library
and its use are covered by this License.

• b) Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modi-
fication of the portions of the Library contained in the Combined Work and reverse engineering for debugging such
modifications, if you also do each of the following:

• a) Give prominent notice with each copy of the Combined Work that the Library is used in it and that the
Library and its use are covered by this License.

• b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

• c) For a Combined Work that displays copyright notices during execution, include the copyright notice for the
Library among these notices, as well as a reference directing the user to the copies of the GNU GPL and this
license document.

• d) Do one of the following:

– 0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding
Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the
Application with a modified version of the Linked Version to produce a modified Combined Work, in the
manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

– 1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one
that (a) uses at run time a copy of the Library already present on the user’s computer system, and (b)
will operate properly with a modified version of the Library that is interface-compatible with the Linked
Version.
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• e) Provide Installation Information, but only if you would otherwise be required to provide such information
under section 6 of the GNU GPL, and only to the extent that such information is necessary to install and
execute a modified version of the Combined Work produced by recombining or relinking the Application with
a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany
the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must
provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying
Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library together with
other library facilities that are not Applications and are not covered by this License, and convey such a combined
library under terms of your choice, if you do both of the following:

• a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any
other library facilities, conveyed under the terms of this License.

• b) Give prominent notice with the combined library that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain
numbered version of the GNU Lesser General Public License “or any later version” applies to it, you have the option
of following the terms and conditions either of that published version or of any later version published by the Free
Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General
Public License, you may choose any version of the GNU Lesser General Public License ever published by the Free
Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General
Public License shall apply, that proxy’s public statement of acceptance of any version is permanent authorization for
you to choose that version for the Library.

14.2 GNU Free Documentation License

Version 1.1, March 2000

Copyright (C) 2000 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

0. Preamble

The purpose of this License is to make a manual, textbook, or other written document "free" in the sense of freedom:
to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially
or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their
work, while not being considered responsible for modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.
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We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter
or whether it is published as a printed book. We recommend this License principally for works whose purpose is
instruction or reference.

1. Applicability And Definitions

This License applies to any manual or other work that contains a notice placed by the copyright holder saying it can
be distributed under the terms of this License. The "Document", below, refers to any such manual or work. Any
member of the public is a licensee, and is addressed as "you".

A "Modified Version" of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals exclusively with the
relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters)
and contains nothing that could fall directly within that overall subject. (For example, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a
matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical
or political position regarding them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License.

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License.

A "Transparent" copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, whose contents can be viewed and edited directly and straightforwardly
with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely
available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of
formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup has
been designed to thwart or discourage subsequent modification by readers is not Transparent. A copy that is not
"Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, La-
TeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML designed
for human modification. Opaque formats include PostScript, PDF, proprietary formats that can be read and edited
only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally
available, and the machine-generated HTML produced by some word processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, "Title Page" means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

2. Verbatim Copying

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that
this License, the copyright notices, and the license notice saying this License applies to the Document are repro-
duced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use
technical measures to obstruct or control the reading or further copying of the copies you make or distribute. How-
ever, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you
must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.
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3. Copying In Quantity

If you publish printed copies of the Document numbering more than 100, and the Document’s license notice requires
Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover
Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify
you as the publisher of these copies. The front cover must present the full title with all words of the title equally
prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the
covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim
copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as
fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a
machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a publicly-
accessible computer-network location containing a complete Transparent copy of the Document, free of added
material, which the general network-using public has access to download anonymously at no charge using public-
standard network protocols. If you use the latter option, you must take reasonably prudent steps, when you begin
distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the
stated location until at least one year after the last time you distribute an Opaque copy (directly or through your
agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. Modifications

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the role
of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy
of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You may
use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of its
principal authors, if it has less than five).

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.

7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Docu-
ment’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section entitled "History", and its title, and add to it an item stating at least the title, year, new
authors, and publisher of the Modified Version as given on the Title Page. If there is no section entitled "-
History" in the Document, create one stating the title, year, authors, and publisher of the Document as given
on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based on.
These may be placed in the "History" section. You may omit a network location for a work that was published
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at least four years before the Document itself, or if the original publisher of the version it refers to gives
permission.

11. In any section entitled "Acknowledgements" or "Dedications", preserve the section’s title, and preserve in the
section all the substance and tone of each of the contributor acknowledgements and/or dedications given
therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers
or the equivalent are not considered part of the section titles.

13. Delete any section entitled "Endorsements". Such a section may not be included in the Modified Version.

14. Do not retitle any existing section as "Endorsements" or to conflict in title with any Invariant Section.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections as
invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice. These
titles must be distinct from any other section titles.

You may add a section entitled "Endorsements", provided it contains nothing but endorsements of your Modified
Version by various parties–for example, statements of peer review or that the text has been approved by an organi-
zation as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the
previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. Combining Documents

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections of
all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its license
notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents, make
the title of each such section unique by adding at the end of it, in parentheses, the name of the original author or
publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in the
list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections entitled "History" in the various original documents, forming one
section entitled "History"; likewise combine any sections entitled "Acknowledgements", and any sections entitled
"Dedications". You must delete all sections entitled "Endorsements."

6. Collections Of Documents

You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided
you insert a copy of this License into the extracted document, and follow this License in all other respects regarding
verbatim copying of that document.
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7. Aggregation With Independent Works

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on
a volume of a storage or distribution medium, does not as a whole count as a Modified Version of the Document,
provided no compilation copyright is claimed for the compilation. Such a compilation is called an "aggregate", and
this License does not apply to the other self-contained works thus compiled with the Document, on account of their
being thus compiled, if they are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is
less than one quarter of the entire aggregate, the Document’s Cover Texts may be placed on covers that surround
only the Document within the aggregate. Otherwise they must appear on covers around the whole aggregate.

8. Translation

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms
of section 4. Replacing Invariant Sections with translations requires special permission from their copyright holders,
but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant
Sections. You may include a translation of this License provided that you also include the original English version of
this License. In case of a disagreement between the translation and the original English version of this License, the
original English version will prevail.

9. Termination

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this
License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will automatically
terminate your rights under this License. However, parties who have received copies, or rights, from you under this
License will not have their licenses terminated so long as such parties remain in full compliance.

10. Future Revisions Of This License

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new
problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License "or any later version" applies to it, you have the option of following the terms and
conditions either of that specified version or of any later version that has been published (not as a draft) by the Free
Software Foundation. If the Document does not specify a version number of this License, you may choose any
version ever published (not as a draft) by the Free Software Foundation.

14.3 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the G-
NU General Public License is intended to guarantee your freedom to share and change free software–to make sure
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the software is free for all its users. This General Public License applies to most of the Free Software Foundation’s
software and to any other program whose authors commit to using it. (Some other Free Software Foundation
software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new
free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all
the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show
them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced by others will not reflect on the original
authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistrib-
utors of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent
this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it
may be distributed under the terms of this General Public License. The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any derivative work under copyright law:
that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated
into another language. (Hereinafter, translation is included without limitation in the term "modification".) Each
licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its
scope. The act of running the Program is not restricted, and the output from the Program is covered only if its
contents constitute a work based on the Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and dis-
claimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and
give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you
also meet all of these conditions:

• a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

• b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from
the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of
this License.
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• c) If the modified program normally reads commands interactively when run, you must cause it, when started
running for such interactive use in the most ordinary way, to print or display an announcement including
an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a
warranty) and that users may redistribute the program under these conditions, and telling the user how to
view a copy of this License. (Exception: if the Program itself is interactive but does not normally print such an
announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Program, and can be reasonably considered independent and separate works in themselves, then this License,
and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute
the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be
on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each
and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather,
the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on
the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you also do one of the following:

• a) Accompany it with the complete corresponding machine-readable source code, which must be distributed
under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

• b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more
than your cost of physically performing source distribution, a complete machine-readable copy of the corre-
sponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange; or,

• c) Accompany it with the information you received as to the offer to distribute corresponding source code.
(This alternative is allowed only for noncommercial distribution and only if you received the program in object
code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable
work, complete source code means all the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally distributed (in either source or bi-
nary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable
runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even
though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or rights, from you under this License
will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do
not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program),
you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or
modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives
a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients’ exercise of the rights granted herein. You are not
responsible for enforcing compliance by third parties to this License.
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7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited
to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict
the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute
so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a
consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free
redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way
you could satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribu-
tion system, which is implemented by public license practices. Many people have made generous contributions to
the wide range of software distributed through that system in reliance on consistent application of that system; it is
up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee
cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Program under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time
to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new
problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License
which applies to it and "any later version", you have the option of following the terms and conditions either of that
version or of any later version published by the Free Software Foundation. If the Program does not specify a version
number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are differ-
ent, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the
two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse
of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE P-
ROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHO-
UT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COP-
YRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS
PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDEN-
TAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OT-
HER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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